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Informazioni sul presente documento 

Convenzioni dei simboli 
Il presente documento potrebbe contenere alcuni simboli il cui significato è indicato di seguito. 

Simbolo Descrizione 

 

PERICOLO indica un pericolo di livello elevato o 
medio che, se non evitato, potrebbe causare lesioni gravi 
o fatali. 

 

AVVERTENZA indica un pericolo di livello basso che, 
se non evitato, potrebbe causare lesioni lievi o medie. 

 

ATTENZIONE indica una situazione potenzialmente 
pericolosa che, se non evitata, potrebbe determinare 
danni, perdita di dati, peggioramento delle prestazioni o 
risultati imprevisti. 

 Indica un suggerimento che potrebbe facilitare e 
velocizzare la soluzione di un problema. 

 Fornisce ulteriori informazioni più dettagliate e 
approfondite sul testo principale. 

 

Convenzioni della GUI 

Convenzione Descrizione 

Grassetto Gli elementi della GUI come pulsanti, menu, parametri, schede 
e finestre; i titoli delle finestre di dialogo sono in grassetto. Ad 
esempio, fare clic su OK. 

> I menu a più livelli sono separati dal segno >. Ad esempio, 
scegliere File > Crea > Cartella. 
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1 Precauzioni per la sicurezza 

Per garantire il funzionamento regolare del modem, leggere con attenzione le precauzioni sulla 
sicurezza prima di utilizzarlo e adottare tali precauzioni durante l'esecuzione delle operazioni. 

Requisiti di base 
� Quando viene conservato, trasportato e utilizzato, accertarsi che il modem sia sempre 

asciutto. 

� Quando viene conservato, trasportato e utilizzato, evitare che il modem urti contro altri 
oggetti. 

� Installare il modem attenendosi scrupolosamente ai requisiti del fornitore. 

� Non disinstallare il modem senza autorizzazione. In caso di guasto del modem, rivolgersi 
al centro di assistenza specifico. 

� È vietato apportare modifiche alla struttura, alla sicurezza o alle prestazioni del modem 
senza autorizzazione. 

� Adoperare il modem nel rispetto delle leggi e regolamenti locali e dei diritti legali altrui. 

Requisiti ambientali 
� Installare il modem in un luogo ben ventilato non esposto direttamente alla luce solare. 

� Tenere pulito il modem. 

� Tenere il modem lontano dall'acqua o dai luoghi umidi. 

� Non appoggiare oggetti sul modem perché potrebbe danneggiarsi, ad esempio 
surriscaldamenti o deformazioni causati da tali oggetti. 

� Lasciare uno spazio di almeno 10 cm attorno al modem per consentire la dissipazione del 
calore. 

� Tenere il modem lontano da fonti di calore o fiamme, ad esempio stufe elettriche e 
candele. 

� Tenere il modem lontano da apparecchiature elettriche che producono campi magnetici o 
elettrici intensi, ad esempio forni a microonde, frigoriferi e telefoni cellulari. 

Istruzioni per l'uso 
� Utilizzare gli accessori forniti con il modem o quelli consigliati dal fornitore, ad esempio 

l'alimentatore e la batteria. 

� La tensione elettrica deve soddisfare i requisiti della tensione di ingresso del modem. 
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� Le prese elettriche devono essere pulite e asciutte per evitare scosse elettriche e altri 
pericoli. 

� Asciugarsi le mani prima di rimuovere o inserire cavi. 

� Arrestare e spegnere il modem prima di rimuovere o inserire cavi. 

� Durante il temporali, spegnere il modem e staccare tutti i cavi, incluso quello di 
alimentazione, le fibre ottiche e i cavi di rete. 

� Se si prevede di non utilizzare il modem per molto tempo, spegnerlo e scollegare la presa 
elettrica. 

� Proteggere il modem dall'acqua o da altri liquidi. Se l'acqua o altri liquidi penetrano nel 
modem, spegnerlo immediatamente e staccare tutti i cavi, compresi quello di 
alimentazione, le fibre ottiche e i cavi di rete. In caso di guasto del modem, rivolgersi al 
centro di assistenza specifico. 

� Non pestare, tirare, tendere o piegare eccessivamente i cavi perché potrebbero 
danneggiarsi. I cavi danneggiati possono causare guasti al modem. 

� Non utilizzare cavi danneggiati o deteriorati. 

� Non guardare direttamente nella porta ottica del modem senza un'opportuna protezione 
oculare. Il laser emesso dalla porta ottica può provocare lesioni oculari. 

� In caso di anomalie, ad esempio fumo, odori o rumori anomali provenienti dal modem, 
spegnerlo immediatamente e staccare tutti i cavi, compresi quello di alimentazione, le 
fibre ottiche e i cavi di rete. In caso di guasto del modem, rivolgersi al centro di 
assistenza specifico. 

� Evitare l'ingresso di corpi estranei, ad esempio oggetti metallici, nel modem attraverso la 
griglia di dissipazione del calore. 

� Non graffiare l'involucro esterno perché la vernice rimossa dai graffi può causare 
malfunzionamenti del modem. Se la vernice penetra nel modem, può provocare 
cortocircuiti. La vernice rimossa può provocare anche reazioni allergiche. 

� Tenere il modem fuori dalla portata dei bambini. Il modem contiene piccoli componenti 
che potrebbero essere ingoiati. 

Istruzioni per la pulizia 
� Prima di pulire il modem, arrestarlo, spegnerlo e staccare tutti i cavi, compresi quello di 

alimentazione, le fibre ottiche e i cavi di rete. Quando si inseriscono e si rimuovono fibre 
ottiche, i connettori delle fibre ottiche devono essere sempre puliti. 

� Non adoperare detergenti fluidi o spray per pulire l'involucro esterno del modem. 
Utilizzare un panno morbido. 

Istruzioni per la salvaguardia dell'ambiente 
� Alla fine del ciclo di vita, smaltire il modem e le batterie presso il luogo di riciclo 

specifico. 

� Rispettare le leggi e i regolamenti locali relativi alla gestione dei materiali di 
imballaggio, delle batterie esauste e dei dispositivi dismessi. 
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2 Introduzione al prodotto 

Questa sezione descrive l'aspetto, le porte e i LED del modem HG8245. 

2.1 HG8245 

Presentazione dell'aspetto, delle interfacce e dei LED del modem HG8245. 

Aspetto 

Figura 2-1 Aspetto del modem HG8245 

 

Porte 

La Figura 3-14 e la Figura 3-15 mostrano rispettivamente le porte presenti sul pannello 
posteriore e sul pannello laterale del modem HG8245. 
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Figura 2-2 Porte del pannello posteriore del modem HG8245 

 

 

Tabella 2-1 Descrizioni delle porte del pannello posteriore del modem HG8245 

Porta e pulsante Funzione 

OPTICAL 

Indica la porta ottica. La porta ottica è dotata di una presa in 
gomma ed è collegata a una fibra ottica per la trasmissione a 
monte. 

La porta OPTICAL richiede un connettore SC/APC. 

LAN1-LAN4 
Indica le porte 10/100/1000M Base-T Ethernet a rilevamento 
automatico (RJ-45) per collegare PC o STB IP. 

TEL1-TEL2 
Indica le porte telefoniche VoIP (RJ-11) per il collegamento 
degli apparecchi telefonici. 

ON/OFF Indica il pulsante di accensione e spegnimento del modem. 

POWER 
Indica la porta di alimentazione per collegare l'alimentatore o 
la batteria di riserva. 
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Figura 2-3 Porte del pannello laterale del modem HG8245 

 

 

Tabella 2-2 Descrizioni delle porte del pannello laterale del modem HG8245 

Porta e pulsante Funzione 

BBU 
Indica la porta di monitoraggio della batteria di riserva 
esterna (NON IN DOTAZIONE E NON DISPONIBILE). 

USB 
È la porta USB per il collegamento di un dispositivo al 
modem. 

WLAN 
Indica il pulsante per accendere e spegnere la rete Wireless 
(WLAN) del modem. 

WPS 

È l'interruttore per avviare il collegamento in modalità 
“automatica” di un dispositivo wireless alla rete wireless del 
modem. 

In questo caso, se il dispositivo da connettere supporta il 
WPS, non è necessario specificare la password di sicurezza 
della rete wireless del modem in quanto questa viene 
scambiata in automatico tra il dispositivo ed il modem. 

RESET 

Premere brevemente il pulsante per far riavviare il modem; 
premere il pulsante per più di 10 secondi per ripristinare le 
impostazioni di fabbrica del modem. 

In questo secondo caso tutte le modifiche apportate 
dall’utente modem e le configurazioni personalizzate 
vengono perse ed andranno effettuate nuovamente. 
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LED 

Figura 2-4 LED del modem HG8245 

 

 

Tabella 2-3 Indicazioni dei LED del modem HG8245 

Serigrafia Nome Stato Indicazione 

POWER 
LED 
alimentazione 

Verde: acceso 
fisso 

Il modem è acceso. 

Arancione: 
acceso fisso 

Il modem è alimentato dalla 
batteria di riserva. 

Spento Il modem non è alimentato. 

PON 
LED 
autenticazione 

Vedere la Tabella 2-4. 

LOS 
LED 
connessione 

Vedere la Tabella 2-4. 

LAN1-LAN4 LED porte LAN Acceso fisso Un dispositivo è connesso alla 
porta LAN ma non sta effettuando 



EchoLife 
HG8040/HG8240/HG8242/HG8245/HG8244T/HG8247/
HG8247a/HG8447 
Service Manual 2 Introduzione al prodotto 

 

Edizione 03 (2014-02-28) Huawei Proprietary and Confidential 
Copyright © Huawei Technologies Co., Ltd. 

10 

 

Serigrafia Nome Stato Indicazione 

traffico. 

Lampeggiante 
È in corso la trasmissione dei dati 
sulla porta LAN. 

Spento 
Nessun dispositivo è connesso alla 
porta LAN o il dispositivo è 
spento. 

TEL1-TEL2 
LED porte 
telefoniche 

Acceso fisso La linea telefonica è attiva. 

Lampeggiamento 
rapido (due volte 
al secondo) 

Il telefono collegato alla porta è in 
conversazione o sta squillando. 

Lampeggiamento 
lento (una volta 
ogni due secondi) 

È in corso l’autenticazione della 
linea telefonica da parte della 
centrale dell’operatore. 

Spento 

La linea telefonica non è attiva 
(possibile problema di linea; 
contattare il Servizio Clienti del 
proprio operatore). 

USB LED porta USB 

Acceso fisso 
Un dispositivo è connesso alla 
porta USB ma non sta effettuando 
traffico. 

Lampeggiamento 
rapido (due volte 
al secondo) 

È in corso la trasmissione dei dati 
sulla porta USB. 

Spento 
Nessun dispositivo è connesso alla 
porta USB o il dispositivo è 
spento. 

WLAN 
LED porta 
WLAN 
(Wireless LAN) 

Acceso fisso 
La rete Wireless del modem 
(WLAN) è attiva. 

Lampeggiante 
È in corso la trasmissione dei dati 
sulla rete Wireless del modem. 

Spento 
La rete Wireless del modem è 
disabilitata. 

WPS LED porta WPS 

Acceso fisso La funzione WPS è abilitata. 

Lampeggiante 
Un terminale Wi-Fi sta accedendo 
al sistema in modalità automatica 
WPS. 

Spento La funzione WPS è disabilitata. 
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Tabella 2-4 Indicazioni dei LED PON e LOS 

N. 
Stato LED 

Indicazione 
PON LOS 

1 Spento Spento 
Il modem è disabilitato dalla 
centrale del provider del servizio. 

2 Lampeggiamento 
rapido (due volte 
al secondo) 

Spento Il modem sta tentando di 
impostare una connessione con la 
centrale del provider del servizio. 

3 Acceso fisso Spento 
La connessione tra modem e 
centrale è impostata. 

4 Spento Lampeggiamento 
lento (una volta 
ogni due secondi) 

La potenza ottica Rx del modem è 
inferiore alla sensibilità del 
ricevitore ottico. 

5 
Lampeggiamento 
rapido (due volte 
al secondo) 

Lampeggiamento 
rapido (due volte 
al secondo) 

La centrale rileva che il modem 
non è autorizzato 
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2.1.2 Accesso logico all'interfaccia Web 

Questa sezione descrive il piano dati e la procedura di accesso all'interfaccia Web di 
configurazione. 

Contesto 

Prima di impostare l'ambiente di configurazione, accertarsi che siano disponibili i dati 
riportati nella Tabella 4-16. 

Tabella 2-5 Piano dati 

Elemento Descrizione 

Nome utente e password Impostazioni predefinite: 
� Utente comune: 

− Nome utente: root 

− Password: admin 

NOTA 

� Dopo l'accesso alla pagina Web, se non 
vengono eseguite operazioni entro 
cinque minuti, la pagina viene bloccata 
e si torna all'interfaccia di accesso. Per 
sbloccare l'account, immettere nome 
utente e password di accesso. 

� Se si immettono nome utente e 
password errati per tre volte, il sistema 
si blocca e si sblocca automaticamente 
dopo un minuto. 

� Cambiare il nome utente e la password 
tramite il Web. 

AVVISO 

Dopo l'accesso alla pagina Web, cambiare 
nome utente e password iniziali. 

Indirizzo IP LAN e maschera di sottorete Impostazioni predefinite: 
� Indirizzo IP: 192.168.100.1 
� Maschera di sottorete: 255.255.255.0 

 

Procedura 

Step 1 Accedere all'interfaccia di configurazione Web del modem. 

1. Lanciare il browser (I.E., Firefox o altro comune browser) ed immettere 
http://192.168.100.1 (192.168.100.1 è l'indirizzo IP predefinito del modem), quindi 
premere Invio per visualizzare l'interfaccia di accesso, come mostrato nella Figura 2-5. 
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2. Nell'interfaccia di accesso del modem, immettere il nome utente e la password. Per i 
dettagli sulle impostazioni predefinite di nome utente e password, vedere la Tabella 2-5. 
Una volta autenticata la password, viene visualizzata la pagina di configurazione Web. 

 

Figura 2-5 Interfaccia di accesso 

 

 

 
L'accesso alla pagina Web supporta SSL3.0, TLS1.0 e TLS1.1. Se si accede al modem tramite https, si 
consiglia di utilizzare TLS1.1 ad elevata sicurezza. La porta TCP 80 viene utilizzata per l'ascolto dei 
pacchetti HTTPS. Per accedere al modem, digitare "https://192.168.100.1:80" nella barra degli indirizzi 
di IE e premere Invio. 
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3 Configurazioni del modem 

Per configurare e visualizzare i parametri del modem dalla pagina Web, è necessario 
accedervi come indicato al punto precedente. 

3.1 LAN 

Questa sezione spiega come configurare il server DHCP. 

3.1.1 Configurazione del server DHCP 

1. Nel menu a sinistra, scegliere LAN > DHCP Server Configuration. Nel riquadro a 
destra è possibile configurare il pool di indirizzi IP che il modem assegnerà, tramite 
DHCP, a tutti i dispositivi connessi via cavo o via wireless (PC, smartphone, tablet, 
NAS, altri apparati domestici). Dopo la configurazione, il dispositivo “client” connesso 
alla porta LAN o alla rete wireless del modem può ottenere automaticamente un 
indirizzo IP dal pool di indirizzi scelto, come mostrato nella Figura 3-2. 

2. Fare clic su Apply. 
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Figura 3-1 Configurazione del server DHCP 

 

 

La Tabella 3-1 riporta i parametri correlati al server DHCP. 

Tabella 3-1 Parametri correlati al server DHCP 

Parametro Descrizione 

Abilita il server DCHP primario Indica se abilitare il server DHCP 
principale. Se la casella di spunta è 
selezionata, è possibile impostare il server 
DHCP principale. 

Abilita il DHCP relay Indica se abilitare il DHCP relay. 

Il DHCP relay è un processo un cui l'inoltro 
tra sottoreti di pacchetti di trasmissione 
DHCP viene implementato tra il client 
connesso e il server DHCP. In questo modo, 
i dispositivi di diverse “sottoreti” possono 
ottenere gli indirizzi IP allocati 
dinamicamente dallo stesso server DHCP. 

Indirizzo IP iniziale Indica l'indirizzo IP iniziale del pool di 
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Parametro Descrizione 

indirizzi IP del server DHCP principale. 
Deve trovarsi nella stessa sottorete 
dell'indirizzo IP impostato in 
"Configurazione del server DHCP". In caso 
contrario, il server DHCP non funziona 
normalmente. 

Indirizzo IP finale Indica l'indirizzo IP finale del pool di 
indirizzi IP del server DHCP principale. 
Deve trovarsi nella stessa sottorete 
dell'indirizzo IP impostato in 
"Configurazione del server DHCP". In caso 
contrario, il server DHCP non funziona. 

Tempo di lease Indica il tempo di lease del pool di indirizzi 
IP sul server DHCP attivo. Opzioni: minuto, 
ora, giorno e settimana. 

Abilita server DHCP secondario Indica se abilitare il server DHCP 
secondario. Se la casella di spunta è 
selezionata, è possibile impostare il server 
DHCP secondario. 

Indirizzo IP Indica l'indirizzo IP del server DHCP 
secondario. 

Maschera di sottorete Indica la maschera di sottorete del server 
DHCP secondario. 

Indirizzo IP iniziale Indica l'indirizzo IP iniziale del pool di 
indirizzi IP del server DHCP secondario. 

Indirizzo IP finale Indica l'indirizzo IP finale del pool di 
indirizzi IP del server DHCP secondario. 

Tempo di lease Indica il tempo di lease del pool di indirizzi 
IP sul server DHCP secondario. Opzioni: 
minuto, ora, giorno e settimana. 

Opzione 60 Indica il campo opzione 60 del server 
DHCP secondario. Un client DHCP lato 
utente può ottenere un indirizzo IP dal pool 
di indirizzi IP sul server DHCP secondario 
solo quando il campo opzione 60 portato dal 
client DHCP lato utente corrisponde a 
questa impostazione. 

Opzione 43 Indica il campo opzione 43 del server 
DHCP secondario, che identifica un server 
TFTP.  

Server NTP Indica l'indirizzo IP del server NTP.  

Server DNS principale Indica l'indirizzo IP del server DNS 
principale. 
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Parametro Descrizione 

Server DNS secondario Indica l'indirizzo IP del server DNS 
secondario. 

 

3.2 Wireless LAN (WLAN) 

Questa sezione spiega come eseguire la configurazione di base e quella avanzata della 
WLAN. 

3.2.1 Configurazione della WLAN di base 

1. Nel menu a sinistra, scegliere WLAN > WLAN Configuration. Nel riquadro a destra, 
selezionare la casella di opzione Enable WLAN. Nella finestra di dialogo visualizzata, 
impostare i parametri Wi-Fi di base, incluse la modalità di autenticazione SSID e la 
modalità di crittografia, come mostrato nella Figura 3-3. 

2. Fare clic su Apply. 
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Figura 3-2 Configurazione della WLAN di base 

 

 

La Tabella 6-4 riporta le configurazioni di rete wireless di base.  

Tabella 3-2 Configurazioni di rete wireless di base 

Parametro Descrizione 

Abilita WLAN Indica se abilitare la rete wireless. I seguenti parametri 
possono essere impostati solo quando la rete wireless è 
abilitata. 

Nome SSID Indica il nome della rete wireless. Viene utilizzato per 
distinguere le diverse reti wireless. Può essere lungo fino a 32 
caratteri, senza spazi o caratteri di tabulazione. Dopo la 
creazione di un ONT, viene creato un SSID1 predefinito, 
WirelessNet. Nel sistema è possibile configurare fino a 
quattro SSID alla volta e non è possibile assegnare indirizzi IP 
ai terminali Wi-Fi in base al SSID. 

Abilita SSID Specifica se abilitare la connessione. 

Numero modem 
associato. 

Specifica il numero di STA. I valori validi sono da 1 a 32. 
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Parametro Descrizione 

SSID trasmissione Indica se abilitare o nascondere la trasmissione. 
� Se la casella di opzione è selezionata, la funzione di 

trasmissione SSID è abilitata. IL MODEM trasmette 
periodicamente il SSID, ossia il nome della rete wireless. 
In tal modo, qualunque STA può cercare la rete wireless. 

� Se la casella di opzione è selezionata, la funzione di 
trasmissione SSID è disabilitata. Il SSID è nascosto e lo 
STA non può cercare la rete wireless. Il SSID può essere 
ottenuto solo tramite una richiesta. 

Abilitazione WMM Specifica se abilitare le funzioni multimediali Wi-Fi. 

Modalità di 
autenticazione 

Indica la modalità di autenticazione con cui lo STA deve 
richiedere l'accesso alla rete wireless. La modalità può essere 
Aperta, Condivisa, Chiave precondivisa WPA, Chiave 
precondivisa WPA2, Chiave precondivisa WPA/WPA2, 
Enterprise WPA, Enterprise WPA2 o Enterprise PA/WPA2. 

L'impostazione predefinita è Aperta, vale a dire che lo STA 
può accedere alla rete senza autenticazione. 

Modalità di crittografia Indica la modalità di crittografia con cui lo STA deve 
richiedere l'accesso alla rete wireless. La modalità di 
crittografia e i parametri di crittografia variano con la modalità 
di autenticazione. 
� Se è impostata la modalità di autenticazione Aperta, è 

possibile impostare la modalità di crittografia Nessuna o 
WEP. 

� Se è impostata la modalità di autenticazione Condivisa, la 
crittografia è WEP. 

� Se è impostata la modalità di autenticazione Chiave 
precondivisa WPA, Chiave precondivisa WPA2, Chiave 
precondivisa WPA/WPA2, Enterprise WPA, Enterprise 
WPA2 o Enterprise WPA/WPA2, è possibile impostare 
la modalità di crittografia AES, TKIP o TKIP&AES. 

 
� La modalità di sicurezza e la crittografia su un terminale Wi-Fi devono corrispondere a quelle di un 

ONT. Se TKIP&AES o la modalità di crittografia AES non è configurata sul terminale Wi-Fi, il 
driver del terminale Wi-Fi potrebbe essere obsoleto. In tal caso, aggiornare la versione del driver. 

� Quando sono configurati due SSID, se si modificano le informazioni di un SSID, l'altro SSID 
sceglierà di nuovo un canale, causando l'interruzione del servizio per alcuni minuti. 

3.3 Sicurezza 
Questa sezione spiega come configurare il filtro indirizzi IP, il filtro indirizzi MAC, DoS e il 
controllo dell'accesso al modem. 
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3.3.1 Configurazione del filtro IP 

1. Nel menu a sinistra, scegliere Security > IP Filter Configuration. Nel riquadro a 
destra, abilitare la funzione del filtro indirizzi IP. Dopo la selezione della modalità del 
filtro (Filter Mode), fare clic su New. Nella finestra di dialogo visualizzata, quindi, 
configurare la regola di filtro degli indirizzi IP dall'interfaccia WAN alla porta LAN, 
come mostrato nella Figura 3-4. 

2. Fare clic su Apply. 

 

Figura 3-3 Configurazione del filtro IP 

 

 

La funzione di filtro degli indirizzi IP è un meccanismo di sicurezza configurato nel modem e 
consente di abilitare o disabilitare, per un segmento di indirizzi IP della LAN, la ricezione di 
traffico internet su alcune o tutte le “porte”. La configurazione del filtro indirizzi IP serve a 
limitare la comunicazione tra un modem ed internet. 

La Tabella 3-3 riporta i parametri correlati al filtro indirizzi IP. 

Tabella 3-3 Parametri correlati al filtro indirizzi IP 

Parametro Descrizione 

Abilita filtro IP Indica se abilitare la funzione di filtro indirizzi IP. 

Modalità filtro Indica la regola di filtro degli indirizzi IP consentiti o non 
consentiti. 
� Non consentiti: indica che è impedito il passaggio dei dati 

che soddisfano la regola nell'elenco delle regole di filtro. 
� Consentiti: indica che è consentito il passaggio dei dati che 

soddisfano la regola nell'elenco di regole di filtro. 
� Ibrido: indica che i pacchetti vengono filtrati in base alla 

direzione a monte o a valle. Alcuni indirizzi IP in direzione 
a monte o a valle possono o non possono passare. 

È possibile selezionare una sola della modalità precedenti. 

Protocollo Indica il tipo di protocollo: TCP/UDP, TCP, UDP, ICMP o 
TUTTI. 
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Parametro Descrizione 

Direzione Indica la direzione in cui si applica la regola di filtro. 
� Bidirezionale: questo valore è disponibile se la Modalità 

filtro è Elenco non consentiti o Elenco consentiti e non 
può essere modificato. 

� A monte: quando questo valore è selezionato in modalità 
ibrida, la regola di filtro si applica nella direzione a monte. 
Nella modalità di filtro ibrida è possibile selezionare solo 
A monte o A valle. 

� A valle: quando questo valore è selezionato in modalità 
ibrida, la regola di filtro si applica nella direzione a valle. 

Priorità Indica la priorità della regola di filtro IP. Questo parametro può 
essere configurato solo quando la Modalità filtro è impostata 
su Ibrido. I valori validi sono da 0 a 255. Un valore più piccolo 
indica una priorità maggiore. Il valore predefinito è 255. 

Indirizzo IP lato LAN Indica l'indirizzo IP lato LAN. 

Porta lato LAN Indica l'ID porta IP lato LAN. Questo parametro può essere 
configurato solo quando Protocollo è impostato su TCP/UDP, 
TCP o UDP. 

Indirizzo IP lato WAN Indica l'indirizzo IP lato WAN. 

Porta lato WAN Indica l'ID porta IP lato WAN. Questo parametro può essere 
configurato solo quando Protocollo è impostato su TCP/UDP, 
TCP o UDP. 

Azione Indica l'azione di filtro IP. 
� Accetta: accetta i pacchetti che soddisfano la regola di 

filtro IP. 
� Scarta: scarta i pacchetti che soddisfano la regola di filtro IP. 

 

3.3.2 Configurazione del filtro MAC 

1. Nel menu a sinistra, scegliere Security > MAC Filter Configuration. Nel pannello a 
destra, dopo aver abilitato il filtro MAC e aver selezionato la modalità di filtro, fare clic 
su New. Nella finestra di dialogo visualizzata, configurare la regola di filtro MAC per 
l'accesso del PC a Internet, come illustrato nella Figura 6-19. 
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Figura 3-4 Configurazione del filtro MAC 

 

2. Fare clic su Apply.  

Gli elenchi di indirizzi MAC dei PC nella rete sono salvati sulil modem. La configurazione 
delle regole di filtro MAC consente ai PC conformi alle regole di accedere al servizio Internet 
o vieta ai PC non conformi alle regole di accedere al servizio Internet. Un PC può avere più di 
un indirizzo IP ma un solo indirizzo MAC. Di conseguenza, la configurazione delle regole di 
filtro MAC controlla efficacemente i diritti di accesso al servizio Internet dei PC in una LAN. 

La Tabella 6-6 descrive i parametri correlati al filtro MAC. 

Tabella 3-4 Parametri correlati al filtro indirizzi MAC 

Parametro Descrizione 

Abilita filtro MAC Indica se abilitare la funzione di filtro 
indirizzi MAC. 

Modalità filtro Indica la regola di filtro degli indirizzi MAC 
consentiti o non consentiti. 
� Non consentiti: indica che è impedito il 

passaggio dei dati che soddisfano la 
regola nell'elenco delle regole di filtro. 

� Consentiti: indica che è consentito il 
passaggio dei dati che soddisfano la 
regola nell'elenco di regole di filtro. 

La modalità di filtro è una modalità di 
configurazione globale, per cui la modalità non 
consentiti e la modalità consentiti non possono 
essere utilizzate contemporaneamente. 

Indirizzo MAC di origine Indica l'indirizzo MAC di origine nella 
regola di filtro indirizzi MAC. 

 

3.3.3 Configurazione del filtro URL 

1. Fare clic sulla scheda Security e scegliere URL Filter Configuration dall'albero di 
navigazione. Nel riquadro a destra, dopo aver abilitato il filtro URL e aver selezionato la 
modalità filtro (Filter Mode), fare clic su Nuovo. Nella finestra di dialogo visualizzata, 
configurare la regola di filtro URL per l'accesso del PC a Internet, come illustrato nella 
Figura 3-6. 

2. Fare clic su Apply. 
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Figura 3-5 Configurazione del filtro URL 

 

 

3.3.4 Configurazione dei protocolli di accesso al modem 

1. Nel menu a sinistra, scegliere Security > ONT Access Control Configuration. Nel 
riquadro a destra, configurare il controllo dell'accesso ONT, come mostrato nella Figura 
3-7. 

2. Fare clic su Apply. 

 

Figura 3-6 Configurazione del controllo di accesso al modem 

 

 

 
Per non rendere accessibile il modem da internet, garantendone l’invulnerabilità da attacchi hacker, si 
sconsiglia vivamente di abilitare i WAN Service FTP/HTTP/Telnet. 
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3.3.5 Configurazione del controllo accesso WAN 

1. Nell'albero di navigazione scegliere Security > WAN Access Control Configuration 
WAN. Nel riquadro a destra, fare clic su New. Nella finestra di dialogo visualizzata, 
impostare i parametri del controllo accesso WAN, come mostrato nella Figura 3-8. 

2. Fare clic su Apply.  

 

Figura 3-7 Configurazione del controllo accesso WAN 

 

3.4 Regole di inoltro (Port Forwarding) 

Questa sezione spiega come configurare DMZ, mappatura porte e trigger di porta. 

3.4.1 Configurazione di DMZ 

1. Nel menu a sinistra, scegliere Regole di inoltro > DMZ Configuration. Nel riquadro a 
destra, fare clic su Nuovo. Nella finestra di dialogo visualizzata, impostare i parametri 
correlati alla DMZ, come mostrato nella Figura 3-8. 

2. Fare clic su Apply.  

 

Figura 3-8 Configurazione di DMZ 

 

 

La zona demilitarizzata (DMZ) è una tecnologia che consente consente a un computer della 
rete locale (LAN) di essere completamente esposto a tutti gli utenti di Internet oppure 
permette la comunicazione reciproca e senza limitazioni tra un dispositivo con un indirizzo IP 
specifico ed i server presenti in Internet. In questo modo è possibile eseguire molte 
applicazioni sul dispositivo con l'indirizzo IP specificato. 
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Se un dispositivo interno alla rete locale LAN non fornisce un servizio Web che dev’essere 
accessibile e fruito da internet, si consiglia di non abilitare sul modem la DMZ poiché tutte le 
porte di un dispositivo configurato in DMZ sono aperte a Internet e quindi raggiungibili anche 
da hacker. 

La Tabella 3-5 descrive i parametri correlati a DMZ. 

Tabella 3-5 Parametri correlati al server DMZ 

Parametro Descrizione 

Abilita DMZ Indica se abilitare la DMZ. 

Nome WAN Indica il nome dell'interfaccia WAN. Se l'interfaccia WAN 
non fa parte della tabella di mappatura porte, le richieste 
dell'applicazione dalla connessione WAN vengono inoltrate 
direttamente al dispositivo in DMZ. 

Indirizzo host Indica l'indirizzo IP del dispositivo in DMZ. 

 

3.4.2 Configurazione della mappatura porte 

1. Nel menu a sinistra, scegliere Regole di inoltro > Port Mapping Configuration. Nel 
riquadro a destra, fare clic su Nuovo. Nella finestra di dialogo visualizzata, impostare i 
parametri correlati alla mappatura porte, come mostrato nella Figura 3-9. 

2. Fare clic su Apply.  

 

Figura 3-9 Configurazione della mappatura porte 
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La mappatura porte consente di raggiungere da internet, su una specifica porta esterna o 
gruppo di porte esterne, un dispositivo interno alla rete locale LAN che funge da server per 
uno o più servizi (ad es. il dispositivo fornisce sia un servizio WWW che un servizio FTP, su 
differenti porte, da esporre su internet). 

La Tabella 3-6 descrive i parametri correlati alla mappatura porte. 

Tabella 3-6 Parametri correlati alla mappatura porte 

Parametro Descrizione 

Abilita mappatura porte Indica se abilitare la mappatura porte 

Nome WAN Indica il nome dell'interfaccia WAN in cui è abilitata la 
mappatura porte. 

Protocollo Indica il tipo di protocollo del pacchetto mappatura porte: 
TCP, UDP o TCP/UDP. 

Porta esterna iniziale Indica la porta iniziale di destinazione del pacchetto dati 
esterno. 

Porta esterna finale: Indica la porta finale di destinazione del pacchetto dati 
esterno. 

Porta interna iniziale Indica la porta iniziale di destinazione interna del pacchetto 
mappatura porte. 

Porta interna finale Indica la porta finale di destinazione interna del pacchetto 
mappatura porte. 

Porta di origine esterna 
iniziale 

Indica la porta iniziale di origine del pacchetto dati esterno. 

Porta di origine esterna 
finale 

Indica la porta finale di origine del pacchetto dati esterno. 

Nome mappatura Indica il nome della regola di mappatura porte. 

Indirizzo IP di origine 
esterno 

Indica l'indirizzo IP di origine del pacchetto dati esterno. 

Host interno Indica l'indirizzo IP del dispositivo a cui è associata la porta. 

 

3.4.3 Configurazione del trigger della porta 

1. Nel menu a sinistra, scegliere Regole di inoltro > Port Trigger Configuration. Nel 
riquadro a destra, fare clic su Nuovo. Nella finestra di dialogo visualizzata, impostare i 
parametri correlati al trigger della porta, come mostrato nella Figura 3-10. 

2. Fare clic su Apply.  
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Figura 3-10 Configurazione del trigger della porta 

 

 

 

La Tabella 6-11 descrive i parametri correlati al trigger della porta. 

Tabella 3-7 Parametri correlati al trigger della porta 

Parametro Descrizione 

Abilita trigger porta Indica se abilitare il trigger della porta. 

Nome WAN Indica il nome dell'interfaccia WAN in cui è abilitato il trigger 
della porta. 

Protocollo trigger Indica il tipo di protocollo del pacchetto trigger porta:TCP, 
UDP o TCP/UDP. 

Protocollo aperto Indica il tipo di protocollo del pacchetto dati aperto. 

Porta trigger iniziale Indica la porta iniziale di destinazione del pacchetto trigger 
porta. 

Porta trigger finale Indica la porta finale di destinazione del pacchetto trigger 
porta. 

Porta aperta iniziale Indica la porta iniziale di destinazione del pacchetto aperto. 

Porta aperta finale Indica la porta finale di destinazione del pacchetto aperto. 

 

3.5 Applicazioni di rete 

Questa sezione spiega come configurare USB, ALG, UpnP e ARP tramite la pagina Web. 



EchoLife 
HG8040/HG8240/HG8242/HG8245/HG8244T/HG8247/
HG8247a/HG8447 
Service Manual 3 Configurazioni del modem 

 

Edizione 03 (2014-02-28) Huawei Proprietary and Confidential 
Copyright © Huawei Technologies Co., Ltd. 

28 

 

3.5.1 Applicazione USB 

1. Nel menu a sinistra, scegliere Network Application > FTP Client Configuration. Nel 
riquadro a destra, impostare i parametri correlati al download FTP per la condivisione 
del file FTP del modem, come illustrato nella Figura 3-11. 

2. Fare clic su Download per scaricare i file dal server FTP sul dispositivo di archiviazione 
USB. 

 

Figura 3-11 Applicazione USB 

 

 

La Tabella 3-8 descrive i parametri correlati a USB. 

Tabella 3-8 Parametri correlati a USB 

Parametro Descrizione 

Configurazione client FTP 

URL FTP Indica il percorso del file scaricato tramite FTP. 

ID porta Indica il numero di porta FTP. L'impostazione predefinita è 
21. In genere questa impostazione non è richiesta. 

Nome utente Indica il nome utente per la connessione al server FTP. Se il 
server FTP supporta l'accesso anonimo, l'impostazione non è 
necessaria. 

Password Indica la password per la connessione al server FTP. Se il 
server FTP supporta l'accesso anonimo, l'impostazione non è 
necessaria. 
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Parametro Descrizione 

Modem USB Indica l'unità del modem USB esterno per il salvataggio del 
file scaricato tramite FTP. Quando si collega il modem di 
archiviazione USB alla porta USB, l'elenco a discesa è 
disponibile. 

Percorso Indica il percorso di salvataggio del file scaricato da FTP sul 
modem USB esterno. Se il percorso non è indicato, per 
impostazione predefinita viene utilizzato il percorso 
specificato nell'URL di download. 

Configurazione server FTP 

Abilita server FTP  Abilita il server FTP quando il modem funge da server FTP.  

Nome utente Imposta il nome utente del server FTP. Tale nome utente è 
necessario quando un altro client FTP accede al server FTP. Il 
nome utente predefinito è root. 

Password Imposta la password del server FTP. Tale password è 
necessaria quando un altro client FTP accede al server FTP. La 
password predefinita è admin. 

Modem USB Indica l'unità del modem USB esterno per il salvataggio del 
file scaricato tramite FTP.  

Percorso root Indica il percorso di salvataggio dei file condivisi quando il 
modem funge da server.  

 

 
FTP non è stato progettato come protocollo sicuro. I dati sensibili degli utenti trasmessi tramite FTP 
sono soggetti ad attacchi. 

 

3.5.2 Configurazione di UPnP 

1. Nel menu a sinistra, scegliere Network Application > UPnP Configuration. Nel 
riquadro a destra, stabilire se abilitare UPnP, come mostrato nella Figura 3-12. 

2. Fare clic su Apply.  

 

Figura 3-12 Configurazione di UPnP 

 

 

UPnP (Universal Plug and Play) è il nome di un gruppo di protocolli per il rilevamento 
automatico di diversi dispositivi di rete. Se UPnP è abilitato nel modem, un dispositivo UPnP 
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collegato dinamicamente alla rete viene rilevato automaticamente da altri dispositivi UPnP e 
viceversa rileva tali dispositivi. 

Inoltre, la mappatura delle porte sul dispositivo connesso avviene automaticamente nel 
modem, senza necessità di configurazioni manuali. 

3.6 Strumenti di sistema 

Questa sezione spiega come utilizzare gli strumenti di sistema, inclusi gli strumenti per riavviare 
il modem, ripristinare la configurazione predefinita ed eseguire il test. 

3.6.1 Riavvio 

Nel menu a sinistra, scegliere System Tools > Reboot. Nel riquadro a destra, fare clic su 
Reboot, come mostrato nella Figura 3-14. 

Figura 3-13 Riavvio 

 

 

 

Salvare la configurazione prima di riavviare il modem. Per i dettagli, vedere 3.6.2 File di 
configurazione. 

3.6.2 File di configurazione 

Nel menu a sinistra, scegliere System Tools > Configuration File. Nel riquadro a destra fare 
clic sul pulsante richiesto, come mostrato nella Figura 3-15. 

Figura 3-14 File di configurazione 

 

 

Successivamente: 
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� Fare clic su Save per salvare il file di configurazione nella memoria flash e impedire la 
perdita di dati dovuta al riavvio del modem. 

� Fare clic su Save and Restart per salvare il file di configurazione e riavviare il modem. 

� Fare clic su Download Configuration File. Nella finestra di dialogo visualizzata, fare 
clic su Save, specificare il percorso in cui salvare il file di configurazione e quindi creare 
un backup del file sul disco locale. 

� Fare clic su Browse dopo la casella di testo Configuration File. Nella finestra di dialogo 
visualizzata, selezionare il file di configurazione da caricare. Fare clic su Update 
Configuration File per caricare il file di configurazione salvato sul disco locale. Una 
volta caricato il file di configurazione, il modem si riavvia automaticamente e viene 
applicata la nuova configurazione. 

 

 

Prima di caricare il file di configurazione, scegliere il file di configurazione corretto. In caso 
contrario, il file di configurazione non viene caricato. 

3.6.3 Aggiornamento del firmware 

1. Nel menu a sinistra, scegliere System Tools > Firmware Upgrade. Nel riquadro a 
destra, fare clic su Browse. Nella finestra di dialogo visualizzata, selezionare la versione 
del software di destinazione del modem. Fare clic su Update Firmware per aggiornare il 
software del modem, come illustrato nella Figura 3-16. 

2. Una volta completato l'aggiornamento, viene visualizzato un messaggio indicante che il 
modem deve essere reimpostato. Fare clic su Restart. I dati di configurazione vengono 
applicati dopo la reimpostazione del modem. 

 

Figura 3-15 Aggiornamento del firmware 

 

  

3.6.4 Ripristino della configurazione predefinita 

Nel menu a sinistra, scegliere System Tools > Restore Default Configuration predefinita. 
Nel riquadro a destra fare clic su Default, come mostrato nella Figura 3-17. 

Figura 3-16 Ripristino della configurazione predefinita 
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Eseguire questa operazione con cautela, in quanto ripristina le impostazioni di fabbrica. 

 

3.6.5 File di log 

Nel menu a sinistra, scegliere System Tools > Log. Nel riquadro a destra, fare clic su 
Download log File. Nella finestra di dialogo visualizzata fare clic su Save, specificare il 
percorso in cui salvare il file di log e salvare il file sul disco locale, come illustrato nella 
Figura 3-18. 

Figura 3-17 File di log 

 

 

Successivamente: 

� Selezionare Save log per abilitare la funzione di salvataggio del file di log nel sistema. 

� Non è possibile configurare il Log Level, che indica il livello del log salvato. Viene 
salvato il log con il livello uguale o superiore al log di livello debug.  

� Fare clic su Download log File. Nella finestra di dialogo visualizzata fare clic su Save, 
specificare il percorso in cui salvare il file di log e salvare il file di log sul disco locale. 

 

3.6.6 Modifica della password di accesso al modem 

1. Fare clic sulla scheda System Tools e scegliere Modify Login Password dall'albero di 
navigazione. Nel riquadro a destra, modificare la password dell'utente root, come 
illustrato nella Figura 3-19. 

2. Fare clic su Apply.  
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Figura 3-18 Modifica della password di accesso 

 

 

 
� Dopo l'accesso dell'utente all'interfaccia Web del modem con nome utente e password predefiniti, 

l'interfaccia Modifica password di accesso viene visualizzata automaticamente con la richiesta di 
modifica della password iniziale. Dopo la modifica della password, l'interfaccia Modifica password 
di accesso non viene più visualizzata all'accesso. 

� Dopo l'accesso alla pagina Web, cambiare nome utente e password iniziali. 
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4 Acronimi e abbreviazioni 

ALG Application Level Gateway 

BRAS Broadband Remote Access Server 

CATV Community Antenna Television 

DBA Dynamic Bandwidth Assignment 

DHCP Dynamic Host Configuration Protocol 

DMZ Demilitarized Zone 

DNS Domain Name Server 

DoS Denial of Service 

FTP File Transfer Protocol 

FTTH Fiber To The Home 

GPON Gigabit-capable Passive Optical Network 

HTTP Hyper Text Transport Protocol 

IGMP Internet Group Management Protocol 

ISP Internet Service Provider 

LAN Local Area Network 

MAC Media Access Control 

NAPT Network Address and Port Translation 

NAT Network Address Translation 

NMS Network Management System 

OLT Optical Line Terminal 

OMCI Optical Network Termination Management and Control Interface 

PON Passive Optical Network 

PPPoE Point to Point Protocol over Ethernet 
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PSTN Public Switched Telephone Network 

SIP Session Initiation Protocol 

SOHO Small Office and Home Office 

SSID Service Set Identifier 

STB Set Top Box 

TCP Transmission Control Protocol 

TKIP Temporal Key Integrity Protocol 

UDP User Datagram Protocol 

UPnP Universal Plug and Play 

URL Uniform Resource Locator 

VLAN Virtual Local Area Network 

VoIP Voice over IP 

WLAN Wireless Local Area Network 

WEP Wired Equivalent Privacy 

WPA Wi-Fi Protected Access 

WPS Wi-Fi Protected Setup 

 


